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PDF books and the information center

PDF books are provided as a convenience for printing and offline reading. For the latest information, see
the online information center.

As a set, the PDF books contain the same content as the information center. Some links within the PDF
books have been tailored for use in the information centers and may not work properly.

The PDF documentation is available within a quarter after a major release of the information center, such
as Version 7.0 or Version 7.5.

The PDF documentation is updated less frequently than the information center, but more frequently than
the Redbooks®. In general, PDF books are updated when enough changes are accumulated for the book.
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Installing IBM Integration Designer

This installation information provides instructions for installing and uninstalling IBM® Integration
Designer and optional features.

Refer to the IBM Integration Designer release notes file for information about product limitations, known
problems, and workarounds. Also, refer to the IBM Integration Designer support site for updated
documentation and troubleshooting information.
Related information:

IBM Installation Manager information center

Planning to install
Planning for IBM Integration Designer before introducing its software into your enterprise information
system helps ensure that the system you implement meets your needs. This section describes how to plan
for IBM Integration Designer.

Test environment
You have the option to use either a local test environment or a remote one. Developers using systems that
are constrained on resources (CPU, memory, disk space) should consider configuring a remote test
environment and pointing their IBM Integration Designer at that remote environment for testing their
processes and monitor models.

As an IBM Integration Designer developer, how you set up a remote environment depends on your target
deployment environment.

IBM Business Monitor

The IBM Integration Designer for IBM Business Monitor option is removed from the installation program
for IBM Integration Designer V8.5. This option is no longer available from the launchpad for Integration
Designer.

Although you cannot install IBM Business Monitor from the Integration Designer launchpad, you can
author the monitor models in Integration Designer V8.5 and deploy them to a remote Business Monitor
V8.0.1 server.

Process Server

In an IBM Integration Designer unit test environment, the server can be installed locally or on a remote
machine. When Process Server is installed locally, IBM Integration Designer finds it and displays it in the
Servers view.

When Process Server is installed remotely, you can target it from IBM Integration Designer by creating a
new server.

Important: Beginning with IBM Integration Designer V8.5, all servers, except for the IBM Integration
Designer unit test environment and IBM BPM Express® servers, are installed with a network deployment
configuration. Testing on a network deployment environment is not supported with IBM Process Server.
Therefore, if Process Server is not already included in the Servers view of the IBM Integration Designer
unit test environment, and you want to create a server to use for testing integration and mediation
modules, make sure the server points to Process Server.
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1. In the Servers view, right-click and select New > Server.
2. Select IBM > IBM Process Server.
3. Specify the remote server host name and click Next.
4. Specify the profile name, connection, and security information, and click Finish.

Process Server via Process Center

If you have a IBM Integration Designer unit test environment, Process Server can be installed locally or
on a remote machine, as described in the previous section. If you have only Process Center, you can
switch to the Process Center perspective and are prompted for connection information to the Process
Center. To target a remote server:
1. In the Process Center, select Window > Preferences.
2. Select Business Integration > Process Center.
3. Specify the Process Center URI, user name, and password.
4. Click Test Connection. If everything is correct, click OK.

Learn about the Process Center by reading Process development with the Process Center. If you
experience communication problems with the remote server, such as problems in publishing to the
remote server or obtaining the status of the server, see Resolving communication problems with remote
servers.

Installing to a unique package group

You can install IBM Integration Designer and the test environment to a unique package group on the
same system with an existing Rational® Application Developer 8.0.x installation. Installation Manager
displays the choice of whether to install into a new package group or into the existing Rational
Application Developer 8.0.x package group.

Security considerations
In IBM Integration Designer V8.5, both administrative security and application security are enabled by
default.

Server security, including administrative security and application security, is automatically enabled for
those test environment servers that you choose to install with IBM Integration Designer V8.5.

Important: Application security is required by IBM Business Process Manager and must not be turned off
in the administrative console.

During installation of the test environment you are prompted for a user name and password to be used
for administering server security.

Note that if you disable or enable server security in a server administrative console, you must ensure that
these changes are also specified for the same server in the server configuration editor or the Window >
Preferences > Server > Security preferences page of IBM Integration Designer.

Information about changing the user ID and password, and about disabling or enabling server security, is
found in the Security documentation in the IBM Integration Designer help: Help > Help Contents. The
embedded assistance help opens. Navigate to IBM Business Process Manager, Version 8.0, All platforms
> Authoring services in Integration Designer > Managing security in IBM Integration Designer.

Coexistence considerations
If you plan to install multiple IBM Eclipse-based products on the same workstation, review the
information in this section.
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Offering coexistence considerations

Some products are designed to coexist and share function when they are installed in the same package
group. A package group is a location where you can install one or more software products or packages to
share a common user interface or workbench. When you install each package, you select whether you
want to install the package to an existing package group, or whether you want to create a new one. IBM
Installation Manager will block products that are not designed to share a package group or do not meet
version tolerance and other requirements. If you want to install more than one product at a time, the
products must be able to share a package group.

Any number of eligible products can be installed to a package group. When a product is installed, its
function is shared with all of the other products in the package group. If you install a development
product and a testing product into one package group, when you start either of the products, you have
both the development and testing functionality available to you in your user interface. If you add a
product with modeling tools, all of the products in the package group will have the development, testing,
and modeling functionality available.

If you want IBM Integration Designer V8.5 to coexist with a Rational software product (for example,
Rational Application Developer for WebSphere® Software), the Rational software product must be at
version 8.5.x or higher. When you have an earlier version of the Rational software product you must
correct this incompatibility by updating the version to 8.5.x or higher, or choose a new package group.
When you want to add a Rational software product to the same package group as IBM Integration
Designer V8.5, you must install it directly at the required 8.5.x (or higher) level by searching for available
updates during the Rational installation (using Check for Other Versions and Extensions), or by pointing
to the 8.5.x update repository location along with the base Rational repository location.

Note: Each product installed into a unique location may be associated with only one package group. A
product must be installed into multiple locations in order to be associated with multiple package groups.

Coexisting installations of IBM Integration Designer

You can install IBM Integration Designer V8.5 onto a system with an existing installation of IBM
Integration Designer V8.5, but the two cannot be part of the same package group.

Similarly, you can install IBM Integration Designer V8.5 onto a system with an earlier installation of IBM
Integration Designer, but the two cannot be part of the same package group.

Non-administrative user considerations
If you are installing IBM Integration Designer as a non-administrative or non-root user, you must have
the DB2 server installed before you begin the installation. Remember the database details so that you can
enter them during the installation.

The considerations described in this topic apply to any install scenario where you choose to install using
the Typical install option. Profiles are created automatically when you install using the Typical option.

To install as a non-administrative user, you have the following choices: 2000Linux 2000Windows

v Before installing the product, install a DB2 server separately. For information about installing DB2 as a
non-administrative or non-root user, see 2000Linux 2000Windows

– 2000Linux Non-root installation overview (Linux and UNIX)

– 2000Windows Required user accounts for installation of DB2 server products (Windows)
v Logon as an administrator and use the product installer to install the DB2 server alone. Grant special

permission to the non-administrative user. Then logon as the non-administrative user and install the
product using the installed DB2 server.
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For additional information, see the following topics in the DB2 information center:
Setting up Windows elevated privileges before installing a DB2 product (Windows)
Required user accounts for installation of DB2 server products (Windows)
Non-root installation overview (Linux and UNIX)

Preparing to install
There are a few tasks which should be completed before beginning the installation process.

Previous versions of IBM Integration Designer cannot be upgraded to V8.5. Different versions of IBM
Integration Designer can coexist on your workstation, but they must not be installed in the same
directory.

Before you install the product, complete these steps:
1. Confirm that your system meets the hardware and software requirements described in System

requirements for IBM Integration Designer.
2. Read the section “Planning to install” on page 1 and give particular attention to the topic

“Coexistence considerations” on page 2.
3. Prepare your operating system following the instructions.

Preparing Linux systems for installation
Before you can install IBM Integration Designer, you must prepare your Linux operating system.

Ensure that you have a supported version of Mozilla Firefox installed.

Because certain steps are specific to a version of the operating system, all steps might not apply to your
environment. If no qualifier is provided for a particular step, complete the step for all versions of the
operating system.

Complete the following steps on your Linux system before installing IBM Integration Designer:
1. Because WebSphere Application Server is a prerequisite of IBM Integration Designer, complete all the

required preparation steps in the Preparing Linux systems for installation topic in the WebSphere
Application Server information center.

2. Increase the allowable stack size, number of open files, and number of processes by adding the
following lines to the end of the /etc/security/limits.conf file or changing the values if the lines
already exist:
# - stack - max stack size (KB)
* soft stack 32768
* hard stack 32768
# - nofile - max number of open files
* soft nofile 65536
* hard nofile 65536
# - nproc - max number of processes
* soft nproc 16384
* hard nproc 16384

Save and close the file, and log off and log in again. You can check the current maximum number of
open files by using ulimit -n. The ulimit requirement is dynamically calculated at installation time
and might need to be larger based on the options you select. For more information about this
setting, run man limits.conf or see the topic Preparing the operating system for product installation
in the WebSphere Application Server information center.

3. Check for the existence of a file named /etc/security/limits.d/90-nproc.conf, which overrides the
nproc value set in the limits.conf file. If the 90-nproc.conf file exists, edit it and set the nproc
values that are specified in the previous step.
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4. Install the following packages for your operating system:

Option Description

Red Hat Enterprise Linux 5 libXp-1.0.0-8

rpm-build-4.4.2-37.el5

You can also install a later release of any of these packages if there are new packages as errata. If
you have additional packages that are specific to your hardware, install them.
The following command example shows how to use the default package manager on supported
Linux distributions.
v Red Hat Enterprise Linux 5:

yum install libXp rpm-build

5. Set the umask value to 077 using the following command:
umask 077

The value 077 is the most restrictive value that IBM Integration Designer will tolerate. You can
optionally choose to set a less restrictive umask value for the following access levels:
v 037 for read-only access for a group of human administrators and tools
v 027 for read and write access for a group of human administrators and tools
v 007 for read, write, and execute access for a group of human administrators and tools

6. On Red Hat Enterprise Linux 5 systems, disable SELinux, or set it to a permissive mode.
7. Restart the computer.
8. Complete the steps in Tuning Linux systems.
9. Ensure all servers involved are set to the same time. Use the same network time protocol for all

servers on all cluster nodes, including application, support, and database clusters. A time mismatch
will cause erratic behavior, including duplicate system tasks.

10. If you are using DB2, make sure that all your DB2 parameters meet the DB2 naming rules.

Preparing Windows systems for installation
Before you can install IBM Integration Designer, you must prepare your Windows operating system.

If you are planning to use DB2 Express with your IBM Integration Designer installation, the user account
must have administrative privileges (Administrator) on the machine where you will perform the
installation.

Because WebSphere Application Server is a prerequisite of the IBM Integration Designer test environment,
you must complete all of the preparation tasks for WebSphere Application Server before installing IBM
Integration Designer if you plan to use the test environment.

Complete the following steps on your Windows system before installing IBM Integration Designer:
1. Complete the steps in the Preparing Windows systems for installation topic in the WebSphere

Application Server information center.
2. Complete the steps in Tuning Windows systems.
3. Ensure all servers involved are set to the same time. Use the same network time protocol for all

servers on all cluster nodes, including application, support, and database clusters. A time mismatch
will cause erratic behavior, including duplicate system tasks.

4. If you are installing on Windows 2008 R2 and you plan to install DB2 Express as part of the IBM
Integration Designer installation, ensure you have compatible Microsoft Visual C++ redistributable
packages. See Errors when running the db2start command in the DB2 information center.

5. If you are using a Czech locale, you must change the system settings to prevent seeing corrupted
characters in IBM Process Portal and IBM Process Designer. Change the Windows settings by
completing the following steps:
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a. Click Regional and Language Options, and open the Administrative tab.
b. In the Language for non-Unicode programs section, click Change system locale . . . to open the

locale list.
c. Select Czech from the list and click OK.

6. If you are using DB2, make sure that all your DB2 parameters meet the DB2 naming rules.

Installing from the product launchpad
The product launchpad provides you with a single location to perform an installation for IBM Integration
Designer.
1. Complete the preinstallation tasks described in “Preparing to install” on page 4, if you have not done

so already.
2. Make sure that the /home directory has 2.2GB of free space. This is required for DB2 installation.

Important: If you are installing IBM Integration Designer with its test environment as a
nonadministrative or nonroot user and you intend to install the test environment, you must install DB2
before you begin the product installation. The DB2 database must be locally installed.

If you are a nonadministrative or nonroot user, you must be authorized to create databases. Typical
installation via the product launchpad validates this authority. If you are not authorized to create
databases, perform the following step:

v 2000Windows Add the user to the DB2ADMNS group. For more information on how to add a user to the
group, refer to Adding your user ID to the DB2ADMNS and DB2USERS user groups (Windows)

v 2000Linux Add the user to the DB2 instance user's primary group. For more information on how to add
a user to the group, refer to Creating group and user IDs for a DB2 database installation (Linux and
UNIX)

2000Windows To install or run IBM Integration Designer on Windows 7, Windows Vista, or Windows Server
2008, you must elevate your Microsoft Windows user account privileges. To install as an administrative
user, right-click launchpad.exe and select Run as administrator.

Use the product launchpad to start the typical installation of IBM Integration Designer in the following
cases:
v Installing from the product DVDs
v Installing from an electronic installation image on your local file system
v Installing from an electronic installation image on a shared drive

To start the launchpad program, complete the following steps. You can run only one launchpad at a time.
1. Insert the first IBM Integration Designer DVD into your DVD drive.

2000Linux Ensure that you have mounted the DVD drive.Alternatively, extract all the files from the
downloadable images. All files should be extracted to the same location on your hard disk.
Overwrite directories if prompted.

2. If the auto-run function is enabled on your system, the IBM Integration Designer launchpad program
automatically opens. If auto-run is not enabled on your system or you are not using a DVD:
v Run launchpad.sh located in the root directory of the DVD or extracted files. If you are running it

from a terminal window, ensure the terminal window's current directory is outside the mounted
file system. For example, use your home directory and specify the path to launchpad.sh.

v Run launchpad.exe, or launchpad64.exe for a 64-bit system, located in the root directory of the
DVD or extracted files.
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3. Select the typical installation environment that you want to install. Based on your selection, your
next screen is configured to emphasize the features that you need. You can change your environment
at a later time in IBM Integration Designer. See “Typical installations and environments” on page 8
for more information.

4. Click Next to continue.
5. Specify the location for the installation.

The default installation path is:

v 2000Windows C:\IBM\IID\v8.5

v 2000Linux root: /opt/IBM/IID/v8.5

v 2000Linux nonroot: user_home/IBM/IID/v8.5
6. Select the features within IBM Integration Designer that you would like to install. See “Available

features” on page 8 for more information.

Note: The features are available for selection only for the IBM Integration Designer for IBM
Business Process Manager Advanced - Process Server and IBM Integration Designer installation
options.

7. Click Next to continue.
8. Specify the information for the Process Server test environment:

Note: You must specify the Process Server information only if you selected the IBM Integration
Designer for IBM Business Process Manager Advanced - Process Server installation option.
v Hostname: This field shows the name of your machine.
v Location: Click Browse to change the installation location.
v The default installation path for the test environment is:

– 2000Windows C:\IBM\IID\PS\v8.5

– 2000Linux root: /opt/IBM/IID/PS/v8.5

– 2000Linux nonroot: user_home/IBM/IID/PS/v8.5
v Specify the Username and Password for the cell administrative account. The cell administrator is

the primary WebSphere Application Server administrator. A user assigned to this role can assign
other administrator roles, and is responsible for the administration of the cell and topology. A user
assigned to this role is not responsible for the administration of the IBM Integration Designer
components. This role provides access to all interfaces, enabling users to alter or delete all types of
available library items and assets, including process applications and toolkits. This role also
enables administration of Process Servers, Performance Data Warehouses, and internal users and
groups. You must be a user assigned to this role to deploy Process Applications on the Process
Center server.

9. Click Next to continue.
10. Specify the Username and Password for the DB2 database connectivity.
11. Click Next to continue.
12. On the Installation summary page, verify the installation options and read the license agreements. If

you agree to the terms of the license agreements, select I have read and accepted the license
agreement and notices.

13. If you want to change the choices that you made on previous pages, click Back and make your
changes. When you are satisfied with your installation choices, click Install Software to install the
package. On the Installation information page, the product and its features that you chose to install
are displayed along with their installation locations. The DB2 databases that you created prior to the
installation are also displayed. A progress indicator shows the percentage of the installation
completed.
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Tip: 2000Linux If you are installing from DVD and get an Eject Error message that prevents you from
ejecting the first disk, it indicates that you are running launchpad.sh in a terminal window with a
current directory inside the mounted file system. If you started launchpad.sh by double-clicking and
selecting Run in Terminal, then you must close the terminal before you can eject the disk. If you
started launchpad.sh in a terminal window, do the following steps to eject the disk:
a. Press Ctrl+Z to pause the process.
b. Type bg 1 to move the process to the background.
c. Change the directory to one outside the mounted file system.
d. Eject the disk.

You can avoid getting the Eject Error message by ensuring that the terminal window's current
directory is outside the mounted file system (for example, the home directory), and specifying the
absolute path to launchpad.sh when you run it.

You have installed a fully functional IBM Integration Designer with a Process Server test environment, if
selected.
Related information:

IBM Installation Manager information center

Typical installations and environments
You select a typical installation configuration from the launchpad when you install IBM Integration
Designer. The preselected configuration you select determines the environment that will be enabled when
IBM Integration Designer starts. You can change the configuration selections during installation or run
Installation Manager at a later time to make changes. You can also change your environment later in IBM
Integration Designer.

IBM Integration Designer for IBM Business Process Manager Advanced - Process
Server

This installation configuration includes an IBM Process Server test environment, and supports IBM
Business Monitor. The following components are selected for installation:
v WebSphere Application Server Network Deployment
v IBM Business Process Manager Advanced - Process Server
v DB2 Express

Note: DB2 Express is installed only if DB2 is not locally installed. If you are a non-root or
non-administrator user, you must already have DB2 installed locally.

v Integration Designer

IBM Integration Designer for WebSphere DataPower

This installation configuration works directly with the WebSphere DataPower Appliance, and does not
include a test environment. Only the Integration Designer package is selected for installation.

IBM Integration Designer

This installation configuration does not include a test environment. Only the Integration Designer
package is selected for installation.

Available features
You can customize your software product by selecting the features of IBM Integration Designer to install.

8 Installing
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When you install the IBM Integration Designer product using the launchpad, you can select which
features within the product to install as per your requirements. A default set of features is selected for
you (including any required features). The launchpad automatically enforces any dependencies between
features and prevents you from clearing any required features.

Adapters can be individually selected. Only install the adapters that you will require.

Note: After you finish installing the product, you can still add or remove features from your software
product by running the Modify Packages wizard in Installation Manager. See “Modifying installations”
on page 29 for more information.

The following table shows the features of IBM Integration Designer that you can choose to install. Default
selections of features to install may vary. If a feature has already been installed, it will not be selected by
default and will not be installed again.

Table 1. Features of IBM Integration Designer that you can choose to install.

Feature group Feature Description Selected by
default

IBM Integration
Designer

The core functionality of IBM Integration Designer.
Provides tools in a comprehensive development
environment to build integrated solutions.

Yes (mandatory)

Tools for
developing
applications
without a local
server installation

Select this option if you do not have this server
installed locally but want to develop applications for
IBM Process Server, V8.5, or WebSphere Enterprise
Service Bus, V8.5, or connect to a remote V8.5 of these
servers.

No

Email, Flat File,
FTP and JDBC
IBM WebSphere
Adapters

Send and receive email to and from an email server
using WebSphere Adapter for Email. Read from, and
write to, a file on a local file system using the
WebSphere Adapter for Flat Files. Read from, and write
to a file on remote system using the WebSphere
Adapter for File Transfer Protocol (FTP). Create and
access services with the database system using
WebSphere Adapter for JDBC.

Yes
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Table 1. Features of IBM Integration Designer that you can choose to install. (continued)

Feature group Feature Description Selected by
default

Additional IBM
WebSphere
Adapters

Adapters access programs and data on Enterprise
Information Systems (EISs).

No

CICS adapter Create and access services to exchange information
with COBOL, C, PL/I programs and data on Customer
Information Control Systems (CICS) transaction
systems.

No

Domino adapter Create a service that exchanges information with an
IBM Domino server. Create integrated processes, which
can create and access Domino documents, without
special coding. During outbound processing the
adapter supports Create, Retrieve, Update, Delete,
Exists and RetrieveAll operations. The adapter receives
a request in the form of a business object from a
service, it processes the request and sends the response
back to the calling component, during inbound
processing, the adapter polls the Domino server at
intervals for Domino documents that are ready for
processing.

No

ECM Adapter Create and access content in an Enterprise content
management system using WebSphere Adapter for
Enterprise Content Management.

No

IMS Adapter Create and access services to exchange information
with COBOL, C, and PL/I programs and data on IBM
Information Management System (IMS) transaction
systems.

No

iSeries Adapter Create and access services that use the program call
markup language (PCML) standard to call an RPG,
COBOL, and service programs on the target IBM i
machine, and send or receive messages to an IBM i
data queue.

No

JD Edwards
Adapter

Create and access services with the JD Edwards
EnterpriseOne Server using WebSphere Adapter for JD
Edwards EnterpriseOne.

No

Oracle Adapter Create and access services to exchange information
with the Oracle E-Business Suite.

No

PeopleSoft
Adapter

Create and access services to exchange information
with WebSphere Adapter for PeopleSoft Enterprise.

No

SAP Adapter Create and access services to exchange information
with the SAP server.

No

Siebel Adapter Create and access services to exchange information
with the Siebel Business Application Server.

No

WebSphere
Adapter Toolkit

Provides the development tools, libraries, and sample
code to assist you in creating JCA resource adapters.

No

2000Windows

Monitor Model
editor

Provides wizards and libraries to help you create
monitor models. It will be installed in your IBM
Integration Designer environment.

Yes
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Table 1. Features of IBM Integration Designer that you can choose to install. (continued)

Feature group Feature Description Selected by
default

Client
development tools

Most applications require client interfaces through
which customers or staff can enter data. This group of
tools is provided to allow you to create customized
clients for your applications.

No

web development
tools

Provides tools for building Web 2.0 and Java EE web
applications using JavaServer Faces (JSF), JavaServer
Pages (JSP), servlets, and HTML. Also provides the
Apache Struts framework for developing Java EE web
applications.

No

WebSphere Portal
Server, version 6.1

The WebSphere Portal Server options provide
development tools to create, customize, test, debug, and
deploy portal applications. Select the "Tools for
developing applications without a local server
installation" option if you do not have the server
installed locally but want to develop applications for
WebSphere Portal Server.

No

WebSphere Portal
Server, version 6.1
on WebSphere
Application
Server, version 8.0

No

WebSphere Portal
Server, version 7.0

No

Lifecycle
integration clients

Provides an asset repository and provides integrations
and client plug-ins for the IBM Rational Team Unifying
Platform.

No

Asset repository
client

The asset repository client is a centrally accessible
location for storing and sharing business process
management (BPM) artifacts. IBM Rational Asset
Manager must be installed and configured on a server
so that the asset repository client can connect to it.

No

Rational
ClearCase® SCM
Adapter

Provides the IBM Rational ClearCase SCM and
ClearCase MVFS plug-ins, which enable versioning of
software artifacts in ClearCase versioned object bases
(VOBs) using snapshot views and dynamic views when
ClearCase VOB and view servers are also installed.

No

Additional
development tools

Provides relational database tools to work with tables,
views, and filters. With these tools, you can create
physical database models by means of reverse
engineering database tables or using DDL scripts. You
can also use the tools to create SQL statements, DB2
routines (such as stored procedures and user-defined
functions), and various types of files. Additionally
provides a graphical editing environment that you can
use to depict Java classes, enterprise beans and other
code elements and artifacts.

No

Related tasks:
“Using the "-clean" option when starting IBM Integration Designer” on page 27
The -clean option can be used on IBM Integration Designer startup and it performs several functions.

Installing IBM Integration Designer silently
You can install the IBM Integration Designer product package in silent installation mode. When you
install in silent mode, the user interface is not available.
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Important: Only one IBM Installation Manager is required to install multiple instances of IBM Integration
Designer.
Related tasks:
“Creating and configuring the test environment profile using BPMConfig” on page 19
You can use the BPMConfig command to create and configure the profile for the IBM Process Server test
environment using a properties file that contains all of the values required for the profile settings.
Related reference:

System requirements for IBM Integration Designer

Installing IBM Integration Designer silently using the command line
You can install IBM Integration Designer using the command line.

Before you install IBM Integration Designer, review the system requirements for the product.

Operating system and software prerequisite levels are particularly important. Although the installation
process automatically checks for prerequisite operating system patches, review the system requirements if
you have not already done so. The system requirements link lists all supported operating systems and the
operating system fixes and patches that you must install to have a compliant operating system. It also
lists the required levels of all prerequisite software.

Important: If you are installing IBM Integration Designer with its test environment as a
nonadministrative or nonroot user and you intend to install the test environment, you must install DB2
before you begin the product installation. The DB2 database must be locally installed.

If you do not have the prerequisite base products necessary for IBM Integration Designer installation, you
must install them as part of the silent installation. The required base products are:
v Installation Manager
v WebSphere Application Server Network Deployment (if you are installing the test environment)

The silent installation performs the following tasks:
v Installs Installation Manager if it is not already installed or updates it to the appropriate level if it is

installed.
v Installs the required base products and IBM Integration Designer.

To silently install IBM Integration Designer, complete the following steps:
1. Run the following command to generate encrypted passwords using IBM Installation Manager to

securely connect to DB2.

Important: If you are running Windows 7, Windows Vista, or Windows Server 2008, start your
command prompt by right-clicking and selecting Run as administrator.

2000Windows

IM_location\eclipse\tools\imutilsc -silent -nosplash encryptString password_to_encrypt

2000Linux

IM_location/eclipse/tools/imutilsc -silent -nosplash encryptString password_to_encrypt

2. Read and accept the license terms before installing. Adding -acceptLicense to the command line
means that you accept all licenses.

3. Run the following command:

Important: If you are running Windows 7, Windows Vista, or Windows Server 2008, start your
command prompt by right-clicking and selecting Run as administrator.
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2000Windows

extract_directory\disk1\IM_win32\tools\imcl install list_of_product_IDs -acceptLicense -installationDirectory location -repositories repository -showVerboseProgress -lo

Note: If you are running on a 64-bit system and do not already have 32-bit Installation Manager
installed, then you must run the command from the extract_directory\IM_win64\tools directory.

2000Linux

extract_directory/disk1/IM_linux/tools/imcl install list_of_product_IDs -acceptLicense -installationDirectory location -repositories repository -showVerboseProgress -lo

Note: If you are running on a 64-bit system and do not already have 32-bit Installation Manager
installed, then you must run the command from the extract_directory/IM_linux64/tools directory.
where:
v list_of_product_IDs is a list of the IDs for the products you want to install, separated by spaces.
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Table 2. Product IDs

Product Product ID Feature Description

IBM Integration
Designer

com.ibm.integration.designer.v85Required: com.ibm.wid,
com.ibm.rad.jre,
com.ibm.wid.product,
com.ibm.rad.jee5,
com.ibm.rad.was80_devtools,
com.ibm.rad.was85_devtools,
com.ibm.rad.j2c,
com.ibm.rad.birt,
com.ibm.rad.transform_authoring,
and com.ibm.rad.pde

Required features

Optional:
com.ibm.wid.bpm.stubs

Tools for developing
applications without a local
server installation

Optional:
com.ibm.wid.adapters.file

E-mail, Flat File, FTP and JDBC
IBM WebSphere Adapters

Optional:
com.ibm.wid.adapters.cics

CICS adapter

Optional:
com.ibm.wid.adapters.domino

Domino adapter

Optional:
com.ibm.wid.adapters.ecm

ECM adapter

Optional
com.ibm.wid.adapters.ims

IMS adapter

Optional
com.ibm.wid.adapters.ios

iSeries adapter

Optional
com.ibm.wid.adapters.jde

JD Edwards adapter

Optional
com.ibm.wid.adapters.oracleebs

Oracle adapter

Optional
com.ibm.wid.adapters.peoplesoft

PeopleSoft adapter

Optional
com.ibm.wid.adapters.sap

SAP adapter

Optional
com.ibm.wid.adapters.siebel

Siebel adapter

Optional
com.ibm.wid.adapters.wat

WebSphere Adapter Toolkit

Optional
com.ibm.wid.adapters.wola

WebSphere Optimized Local
Adapter

Optional com.ibm.wid.mme Monitor Model editor (Windows
only)

Optional
com.ibm.rad.webtools_core

Web development tools

Optional
com.ibm.rad.portal.v70.tools

WebSphere Portal Server Beta
development tools

Optional
com.ibm.ram.core.client

Asset repository client

Optional
com.ibm.rad.clearcase

Rational ClearCase SCM adapter

Optional
com.ibm.wid.dev_tools

Additional development tools

Optional
com.ibm.wid.bpmps.user

IBM Business Process Manager
Advanced - Process Server
environment

14 Installing



v location is the path to the directory where you want to install the products.
v repository is the path to the repository where you have extracted the files, one or more of the

following directories:
extract_directory/disk1/IM_win32
extract_directory/disk1/IM_linux
extract_directory/disk1/diskTag.inf

For more than one repository, separate the repository locations with commas.
v logName is the name of the log file to record messages and results.

Running this command installs the product with the default features. If you want to install specific
features or make other changes, see the reference link for the command-line arguments for imcl.

4. If you also want to install the test environment, run the same command again with a different
installation directory and the required product IDs and keys:

2000Windows

extract_directory\disk1\IM_win32\tools\imcl install list_of_product_IDs -acceptLicense -testInstallationDirectory location -repositories repository -properties key=valu

Note: If you are running on a 64-bit system and do not already have 32-bit Installation Manager
installed, then you must run the command from the extract_directory\IM_win64\tools directory.

2000Linux

extract_directory/disk1/IM_linux/tools/imcl install list_of_product_IDs -acceptLicense -testInstallationDirectory location -repositories repository -properties key=valu

Note: If you are running on a 64-bit system and do not already have 32-bit Installation Manager
installed, then you must run the command from the extract_directory/IM_linux64/tools directory.
where:
v list_of_product_IDs is a list of the IDs for the products you want to install, separated by spaces.

Table 3. Product IDs for test environment

Product Product ID Feature Description

IBM Integration Designer com.ibm.bpm.PS.v85 AdvancedProcessServer.NonProductionTest, staging, or
development use

Must specify this feature
or bpmAdvPS.prod
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Table 3. Product IDs for test environment (continued)

Product Product ID Feature Description

WebSphere Application Server
Network Deployment

com.ibm.websphere.ND.v80core.feature Required WebSphere
Application Server core
content

ejbdeploy pre-EJB 3.0 modules

thinclient standalone thin clients
and resource adapters

embeddablecontainer embeddable EJB
container

samples sample applications
feature

com.ibm.sdk.6_32bit 32-bit SDK

Must specify this feature
or com.ibm.sdk.6_64bit.

com.ibm.sdk.6_64bit 64-bit SDK

Can only be selected on a
64-bit system

Must specify this feature
or com.ibm.sdk.6_32bit.

Installation Manager com.ibm.cic.agent agent_core Installation Manager core
content

agent_jre Installation Manager JRE

DB2 for Linux 32-bit com.ibm.ws.DB2EXP.linuxia32N/A DB2 must match the
system OS and bit
specification

DB2 for Linux 64-bit com.ibm.ws.DB2EXP.linuxia64N/A DB2 must match the
system OS and bit
specification

DB2 for Windows 32-bit com.ibm.ws.DB2EXP.winia32N/A DB2 must match the
system OS and bit
specification

DB2 for Windows 64-bit com.ibm.ws.DB2EXP.winia64N/A DB2 must match the
system OS and bit
specification

v location is the path to the directory where you want to install the products.
v repository is the path to the repository where you have extracted the files, one of the following

directories:
extract_directory/repository/repos_32bit
extract_directory/repository/repos_64bit

For more than one repository, separate the repository locations with commas.
v key=value is a list of the keys and values you want to pass to the installation, separated by commas.

Do not put spaces between the commas.
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Table 4. Keys for test environment.

Key Description

user.select.64bit.image If you are installing on a 64-bit operating system, add the
following line exactly:

user.select.64bit.image,,com.ibm.websphere.ND.v80=true

The default value is false.

user.db2.admin.username Windows only. User name with authority to access the
DB2 database. The default value is bpmadmin.

user.db2.admin.password Windows only. Password for the user name above.
Choose a password that complies with the password
policy of your system (for example, Windows 2008).

user.db2.port Port for the DB2 database. The default value is 50000.

user.db2.instance.username Linux only. DB2 instance user name.

user.db2.instance.password Linux only. Password for the user name above.

user.db2.fenced.username Linux only. Fenced user name.

user.db2.fenced.password Linux only. Password for the user name above.

user.db2.das.username Linux only. Administration server (DAS) user name.

user.db2.das.password Linux only. Password for the user name above.

v logName is the name of the log file to record messages and results.

Running this command installs the test environment with the default features. If you want to install
specific features or make other changes, see the reference link for the command-line arguments for
imcl.

Installation Manager installs the list of products and writes a log file to the directory that you specified.

After you have installed the product, create the deployment test environment and profile using the
BPMconfig command.
Related tasks:
“Creating and configuring the test environment profile using BPMConfig” on page 19
You can use the BPMConfig command to create and configure the profile for the IBM Process Server test
environment using a properties file that contains all of the values required for the profile settings.
Related reference:

System requirements for IBM Integration Designer

Command-line arguments for imcl

Installing IBM Integration Designer silently using a response file
You can install the IBM Integration Designer product package in silent installation mode. When you
install in silent mode, the user interface is not available. Instead, you run a command to use a response
file that installs the product.

Before you install IBM Integration Designer, review the system requirements for the product.

Operating system and software prerequisite levels are particularly important. Although the installation
process automatically checks for prerequisite operating system patches, review the system requirements if
you have not already done so. The system requirements link lists all supported operating systems and the
operating system fixes and patches that you must install to have a compliant operating system. It also
lists the required levels of all prerequisite software.
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Important: If you are installing IBM Integration Designer with its test environment as a
nonadministrative or nonroot user and you intend to install the test environment, you must install DB2
before you begin the product installation. The DB2 database must be locally installed.

If you do not have the prerequisite base products necessary for IBM Integration Designer installation, you
must install them as part of the silent installation. The required base products are:
v Installation Manager
v WebSphere Application Server Network Deployment (if you are installing the test environment)

The silent installation performs the following tasks:
v Installs Installation Manager if it is not already installed or updates it to the appropriate level if it is

installed.
v Installs the required base products and IBM Integration Designer.

To silently install IBM Integration Designer, complete the following steps:
1. Read and accept the license terms before installing. Adding -acceptLicense to the command line

means that you accept all licenses.
2. Create the response file that will install the required base products and IBM Integration Designer.

Copy a sample response file, suitable for your operating system and user access level, from one of the
following directories:

To install both IBM Integration Designer and the test environment: extract_directory/
responsefiles/iid_testenv/

To install IBM Integration Designer alone: extract_directory/responsefiles/iid/

Alternatively, you can create a response file by recording your actions in Installation Manager. When
you record a response file, the selections that you make in Installation Manager are stored in an XML
file. When you run Installation Manager in silent mode, Installation Manager uses the data in the
XML response file to perform the installation.

3. The default values provided in the sample response files will perform a basic install, but you should
review the file and its comments, and modify the parameters as needed for your environment.

Important: Verify that the repository locations in your response file point to the correct location in
your environment and that other parameter values are also appropriate.

4. Run the following command:

Important: If you are running Windows 7, Windows Vista, or Windows Server 2008, start your
command prompt by right-clicking and selecting Run as administrator.

To install IBM Integration Designer and the test environment: 2000Windows

extract_directory\IM_win32\installc.exe -acceptLicense input ..\responsefiles\response_file_name.xml -log silent.log

Note: If you are running on a 64-bit system and do not already have 32-bit Installation Manager
installed, then you must run the command from the extract_directory\IM64\tools directory.

2000Linux

extract_directory/IM_linux/installc -acceptLicense input ../responsefiles/response_file_name.xml -log silent.log

Note: If you are running on a 64-bit system and do not already have 32-bit Installation Manager
installed, then you must run the command from the extract_directory/IM64/tools directory.

To install IBM Integration Designer alone: 2000Windows

extract_directory\IM_win32\installc -acceptLicense input ..\responsefiles\response_file_name.xml -log silent.log

2000Linux

extract_directory/IM_linux/installc -acceptLicense input ../responsefiles/response_file_name.xml -log silent.log
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Installation Manager installs any required prerequisites and IBM Integration Designer and writes a log
file to the directory you specified.

Attention: When you install the IBM Integration Designer and the UTE on Linux platform under the
/home or /opt directories you are likely to receive a warning output or log message indicating that there
has been an error during the installation of DB2 Express. The error message will read as
follows:Warnings were encountered during installation of DB2 Express.See DB2 Express installation
log file /opt/IBM/BPM8.0/logs/db2install.log for more information. This is an expected behavior on
Linux platform, and does not indicate installation failure. Proceed with the rest of the installation to
complete it.

After you have installed the product, create the deployment test environment and profile using the
BPMconfig command.
Related tasks:

Installing silently with Installation Manager

Recording a response file with Installation Manager
“Creating and configuring the test environment profile using BPMConfig”
You can use the BPMConfig command to create and configure the profile for the IBM Process Server test
environment using a properties file that contains all of the values required for the profile settings.
Related reference:

System requirements for IBM Integration Designer

Creating and configuring the test environment profile using
BPMConfig
You can use the BPMConfig command to create and configure the profile for the IBM Process Server test
environment using a properties file that contains all of the values required for the profile settings.

You must have installed IBM Integration Designer and the test environment silently using the command
line or response file.

Ensure that the DB2 command line environment can be successfully invoked.

v 2000Windows To check, run db2cmd from the command prompt. This should open a DB2 command line
interface.

v 2000Linux To check, run db2 from the terminal. This should identify the DB2 command location.

If you are a nonadministrative or nonroot user, you must be authorized to create databases. If you are not
authorized to create databases, perform the following step to acquire authorization:

v 2000Windows Add the user to the DB2ADMNS group. For more information on how to add a user to the
group, refer to Adding your user ID to the DB2ADMNS and DB2USERS user groups (Windows)

v 2000Linux Add the user to the DB2 instance user's primary group. For more information on how to add
a user to the group, refer to Creating group and user IDs for a DB2 database installation (Linux and
UNIX)

When run with the -create -de options, the BPMConfig command performs the following tasks:
v Creates a standalone profile for the IBM Process Server test environment
v Configures the test environment profile

To create and configure the profile for the IBM Process Server test environment, complete the following
steps:
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1. On the system where you want to create the test environment profile, locate the sample properties file
Advanced-PS-Standalone-DB2.properties at the following path:

2000Linux extract_directory/launchpad/content/samples/config/iid

2000Windows extract_directory\launchpad\content\samples\config\iid

2. Create a copy of the above sample properties file.
3. Modify your version of the properties file so that the values correspond to your own configuration. To

create the test environment profile for IBM Integration Designer, clear out or update the default
variable values assigned to the required properties.

Table 5. BPMConfig command properties that must be set.

The following table lists the properties and the values that you must set:

Configuration properties Values to set

bpm.de.psProcessCenterHostname
bpm.de.psProcessCenterPort

The Process Server test environment is an offline server
configuration. Clear the default values @PS_PC_HOSTNAME@ and
@PS_PC_PORT@ specified for the host name and port number.

bpm.de.authenticationAlias.1.name=DeAdminAlias
bpm.de.authenticationAlias.1.user
bpm.de.authenticationAlias.1.password

Retain the default value DeAdminAlias for authentication alias for
the test environment administrator. See IBM Business Process
Manager security roles for more information about the roles.

If you change the value for bpm.de.authenticationAlias.1.alias from
the default DeAdminAlias, you must update it everywhere that
references that alias, for example bpm.de.roleMapping.#.alias

Specify custom user name and password for the authentication alias
for the test environment administrator.

bpm.de.authenticationAlias.2.name=ProcessCenterUserAlias
bpm.de.authenticationAlias.2.user
bpm.de.authenticationAlias.2.password

The Process Server test environment is an offline server
configuration. Clear the default values specified for the user name
and password for the ProcessCenterUserAlias authentication alias.

bpm.de.authenticationAlias.3.name=BPM_DB_ALIAS
bpm.de.authenticationAlias.3.user
bpm.de.authenticationAlias.3.password

Retain the default value BPM_DB_ALIAS for authentication alias
for the database instance.

Specify custom user name and password for the authentication alias
for the database user.

bpm.cell.authenticationAlias.1.name=CellAdminAlias
bpm.cell.authenticationAlias.1.user
bpm.cell.authenticationAlias.1.password

Retain the default value CellAdminAlias for authentication alias for
the cell. See IBM Business Process Manager security roles for more
information about the roles.

Specify custom user name and password for the authentication alias
for the cell administrator.

bpm.de.node.1.hostname
bpm.de.node.1.installPath
bpm.de.node.1.profileName

Update the default value @INSTALL_HOSTNAME@ to specify the
host name of the computer where the product is installed.

Update the default value @INSTALL_PATH@ to specify the
installation path of the test environment.

Update the default value @SERVER_PROFILE_NAME@ for the
profile name to qbpmps.

bpm.de.db.1.hostname
bpm.de.db.1.portNumber
bpm.de.db.1.schema

Update the default value @DB_HOSTNAME@ to specify the host
name of the database.

Update the default value @DB_PORTNUMBER@ to specify the port
number of the DB2 service.

Update the default value @DB_SCHEMA@ to specify the user name
for the DB2 database in CAPITAL letters.
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Table 5. BPMConfig command properties that must be set (continued).

The following table lists the properties and the values that you must set:

Configuration properties Values to set

bpm.de.db.1.databaseName
bpm.de.db.2.databaseName
bpm.de.db.3.databaseName

Update the default value @CMN_DB_NAME@ for the Common
database to QCMNDB.

Update the default value @PS_DB_NAME@ for the Process
database to QBPMDB.

Update the default value @PDW_DB_NAME@ for the Performance
Data Warehouse database to QPDWDB.

For more information about the BPMConfig command properties, read the comments in the sample
files, or see the sample property file descriptions in Sample configuration properties files for use with
the BPMConfig command.

4. Add the property bpm.de.createDatabase in the properties file and set its value set to true.
5. Run the BPMConfig command passing it the name of the properties file you created. For example:

2000Linux

BPM_home/bin/BPMConfig -create -de my_environment.properties

2000Windows

BPM_home\bin\BPMConfig -create -de my_environment.properties

Create a copy of the updated properties file, rename this copied version to Standalone.properties, and
place this file at the location <WTE_HOME>/properties/wte. This ensures that the Server Reset feature in
Integration Designer functions properly.

After you have created test environment profile, you can start the test profile by running the BPMconfig
command with the -start action.
Related tasks:
“Installing IBM Integration Designer silently using a response file” on page 17
You can install the IBM Integration Designer product package in silent installation mode. When you
install in silent mode, the user interface is not available. Instead, you run a command to use a response
file that installs the product.
“Installing IBM Integration Designer silently” on page 11
You can install the IBM Integration Designer product package in silent installation mode. When you
install in silent mode, the user interface is not available.
“Installing IBM Integration Designer silently using the command line” on page 12
You can install IBM Integration Designer using the command line.

Working with IBM Installation Manager
This section deals with some common tasks relating to IBM Installation Manager. For more information,
see the Installation Manager information center.
Related information:

IBM Installation Manager information center

Installing Installation Manager on Windows
If you start the installation of your product from the launchpad program, then the installation of IBM
Installation Manager is performed automatically if it is not already installed on your workstation. (For
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more information on this process, refer to “Installing from the product launchpad” on page 6.) In other
cases, you must manually start the installation of Installation Manager.

To install Installation Manager manually:
1. Run install.exe from the IM_win32 folder in the installation image.

Note: If you are running on a 64-bit system and do not already have 32-bit Installation Manager
installed, then you must run the command from the IM_win64 directory.

2. Click Next on the Install Packages page.
3. Review the license agreement on the License Agreement page and select I accept the terms in the

license agreement to accept. Click Next.
4. Click the Browse button on the Destination Folder page to change the installation location if required.

Click Next.
5. Click Install on the Summary page. When the installation process is complete, a message confirms the

success of the process.
6. Click Finish. IBM Installation Manager opens.

Installing Installation Manager on Linux
If you start the installation of your product from the launchpad program, then the installation of IBM
Installation Manager is performed automatically if it is not already installed on your workstation. For
more information on this process, refer to “Installing from the product launchpad” on page 6.

To install Installation Manager manually:
1. Open a terminal window with root user privileges.
2. Run install from the IM_linux folder in the installation image.

Note: If you are running on a 64-bit system and do not already have 32-bit Installation Manager
installed, then you must run the command from the IM_linux64 directory.

3. Click Next on the Install Packages screen.
4. Review the license agreement on the License Agreement page and select I accept the terms in the

license agreement to accept. Click Next.
5. If necessary, edit the installation directory location. Click Next.
6. Click Install on the information summary page. When the installation process is complete, a message

confirms the success of the process.
7. Click Finish. If you start the installation of your product from the launchpad program, then the

installation of IBM Installation Manager is performed automatically if it is not already installed on
your workstation.

Starting Installation Manager on Windows
If you start the installation of your product from the launchpad program, then the installation of IBM
Installation Manager is performed automatically if it is not already installed on your workstation. This
automatic installation starts Installation Manager with a configured repository preference and selected
IBM Integration Designer packages. If you start Installation Manager directly, then you must set a
repository preference and choose product packages manually. For more information, see “Setting
repository preferences in Installation Manager” on page 26.

To start Installation Manager manually:
1. Open the Start menu from the Taskbar.
2. Select All Programs > IBM Installation Manager > IBM Installation Manager.
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Starting Installation Manager on Linux
If you start the installation of your product from the launchpad program, then the installation of IBM
Installation Manager is performed automatically if it is not already installed on your workstation. This
automatic installation starts Installation Manager with a configured repository preference and selected
IBM Integration Designer packages. If you start Installation Manager directly, then you must set a
repository preference and choose product packages manually. For more information, see “Setting
repository preferences in Installation Manager” on page 26.

To start Installation Manager manually:
1. Open a terminal window with root user privileges.
2. Change directory to the installation directory for Installation Manager (by default,

/opt/IBM/InstallationManager/eclipse for an installation by a root user; user_home/IBM/
InstallationManager/eclipse for an installation by a non-root user) and run IBMIM.

Uninstalling Installation Manager on Windows
To uninstall Installation Manager manually:
1. Click Start > Settings > Control Panel, and then double-click Add or Remove Programs.
2. Select the entry for IBM Installation Manager and click Remove

Uninstalling Installation Manager on Linux
IBM Installation Manager must be uninstalled using the package management tool that is included with
your Linux version.

To uninstall Installation Manager manually on Linux, use one of the following methods:
v On the menu, click Applications > System Tools. Select IBM Installation Manager > Uninstall IBM

Installation Manager.
v Open a terminal window with root user privileges. Change directory to the uninstallation directory of

Installation Manager. By default, this is /var/ibm/InstallationManager/uninstall. Run ./uninstall.

Updating Installation Manager through a proxy server
Proxy servers enable connections to remote servers from behind a firewall. You can set preferences for
proxy servers in Installation Manager or in a response file. After the proxy server is enabled, the proxy
server is used for all server communications. For details on how to configure Installation Manager for a
proxy server see Internet Preferences in the Installation Manager information center.

Overview
IBM Installation Manager is a program that helps you install the IBM Integration Designer packages on
your workstation. It also helps you update, modify, and uninstall this and other packages that you install.
A package can be a product, a group of components, or a single component that is designed to be
installed by the Installation Manager.

IBM Installation Manager offers a number of time-saving features. It keeps track of what you are about to
install, software components that you have already installed, and components that are available for you
to install. It searches for updates so you know that you are installing the latest version of an IBM
Integration Designer product package. Installation Manager also provides tools for managing licenses for
the product packages that it installs. It provides tools for updating and modifying packages. You can also
use Installation Manager to uninstall product packages.

Installation Manager comprises seven wizards that make it easy to maintain your product packages
through their lifecycles:
v The Install Packages wizard walks you through the installation process. You can install a product

package by simply accepting the defaults, or you can modify the default settings to create a custom
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installation. Before you install a product package, you are provided with a complete summary of the
selections that you have made throughout the wizard. With the wizard you can install one or more
product packages at the same time.

v The Update Packages wizard searches for available updates to product packages that you have
installed. An update might be a released fix, a new feature, or a new version of the product. Details of
the contents of the update are provided in the wizard. You can choose whether to apply an update.

v With the Modify Packages wizard, you can modify specific elements of a package that you have
already installed. During your initial installation of the product package, you select the features you
want to install. If you find later that you require other features, you can use the Modify Packages
wizard to add them to your product package installation. You can also remove features, and add or
remove languages.

v The Manage Licenses wizard helps you to set up the licenses for your packages. Use this wizard to
change your trial license to a full license, to set up your servers for floating licenses, and to select
which type of license to use for each package. This wizard is not used for the IBM Integration Designer
packages.

v The Import wizard helps you to add existing packages that were installed using installation tools other
than Installation Manager so that they can be managed by Installation Manager.

v With the Roll Back Packages wizard you can revert to a previously installed version of an eligible
package.

v The Uninstall Packages wizard helps you to remove a product package from your computer. You can
uninstall more than one package at a time.

Related information:

IBM Installation Manager information center

Silently installing and uninstalling Installation Manager
IBM Installation Manager can be silently installed and uninstalled.
Related information:

IBM Installation Manager information center

Silently installing Installation Manager
To install Installation Manager silently, extract the installer and switch to the InstallerImage_platform
subdirectory, then use the following commands:

v 2000Windows extract_directory\IM_win32\installc --launcher.ini -acceptLicense silent-install.ini
-log <log file path and name>. For example, extract_directory\IM_win32\installc --launcher.ini
-acceptLicense silent-install.ini -log c:\mylogfile.xml

Note: If you are running on a 64-bit system and do not already have 32-bit Installation Manager
installed, then you must run the command from the IM_win64 directory.

v 2000Linux extract_directory/IM_win32/install --launcher.ini -acceptLicense silent-install.ini
-log <log file path and name>. For example, extract_directory/IM_win32/install --launcher.ini
-acceptLicense silent-install.ini -log /root/mylogs/mylogfile.xml

Note: If you are running on a 64-bit system and do not already have 32-bit Installation Manager
installed, then you must run the command from the IM_linux64 directory.

After installation, you can use Installation Manager or the Installation Manager installer to silently install
packages.

Silently uninstalling Installation Manager from Windows
To silently uninstall Installation Manager on Windows:
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1. From a command line, go to the uninstall directory for the Installation Manager. By default, this is
C:\Documents and Settings\All Users\Application Data\IBM\Installation Manager\uninstall.

2. Enter the following command: uninstallc.exe --launcher.ini silent-uninstall.ini

Silently uninstalling Installation Manager on Linux
To silently uninstall Installation Manager on other platforms:
1. From a terminal window, go to the directory uninstallation directory of Installation Manager. By

default, this is /var/ibm/InstallationManager/uninstall).
2. Run the following command: uninstall --launcher.ini silent-uninstall.ini

Package groups and the shared resources directory
When you install the IBM Integration Designer package using IBM Installation Manager, you must choose
a shared resources directory (if IBM Integration Designer is the first product to be installed using
Installation Manager) and a package group.

Package groups

During the installation process, you must specify a package group for the IBM Integration Designer
package. A package group represents a directory in which packages share a common user interface or
workbench with other packages in the same group. When you install the IBM Integration Designer
package using Installation Manager, you can create a new package group or install the packages into an
existing package group. Some packages might not be able to share a package group, in which case the
option to use an existing package group will be disabled.

Note that when you install multiple packages at the same time, all the packages are installed into the
same package group.

A package group is assigned a name automatically; however, you choose the installation directory for the
package group.

You can use the IBM Packaging Utility to:
v Generate a new repository for packages
v Copy packages to a new repository
v Delete packages that are no longer needed.

For more information see The IBM Packaging Utility .

After you create the package group by successfully installing a product package, you cannot change the
installation directory. The installation directory contains files and resources specific to the IBM Integration
Designer package installed into that package group. Eclipse plug-ins in the product package that can
potentially be used by other package groups are placed in the shared resources directory.

Shared resources directory

The shared resources directory is the directory where Eclipse plug-ins are located so that they can be used
by one or more product package groups.

Important: You can specify the shared resources directory once: the first time that you install a package.
For best results, use your largest drive for the shared resources directory. You cannot change the directory
location unless you uninstall all packages.
Related information:

IBM Installation Manager information center
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Setting repository preferences in Installation Manager
If you start Installation Manager directly (for example from a repository located on a web server), you
must specify the URL for the directory that contains the product package in Installation Manager before
you can install the product package.

By default, Installation Manager uses an embedded URL in each software development product to
connect to a repository server through the Internet and search for installable packages and new features.
Your organization may require you to redirect the repository to use intranet sites.

Note: If not installing from DVD or a local installation image, obtain the installation package repository
URL from your administrator before starting the installation process.

To add, edit, or remove a repository location in Installation Manager:
1. Start Installation Manager.
2. On the Start page of Installation Manager, click File > Preferences, and then click Repositories. The

Repositories page opens, showing any available repositories, their locations, and whether they are
accessible.

3. On the Repositories page, click Add Repository.
4. In the Add repository window, type the URL of the repository location or browse to it and set a file

path. The repository location is typically image_directory/repository.config, where image_directory
contains the extracted installation image of the product you want to install.

5. Click OK. The new or changed repository location is listed. If the repository is not accessible, a red x
is displayed in the Accessible column.

6. Click OK to exit.

Note: If you want the Installation Manager to search the default repository locations for the installed
packages, ensure that the Search service repositories during installation and updates preference on the
Repositories preference page is selected.
Related information:

IBM Installation Manager information center

Starting IBM Integration Designer
You can start IBM Integration Designer from the desktop environment or a command-line interface.
v To start IBM Integration Designer from the desktop environment:

– 2000Windows Click Start > Programs > IBM > package group name > IBM Integration Designer 8.0. For
example, click Start > Programs > IBM > IBM Integration Designer > IBM Integration Designer
8.0.

– 2000Linux Select the product shortcut on the main menu under package group name > IBM
Integration Designer 8.0. For example, click IBM Integration Designer > IBM Integration Designer
8.0.

v To start IBM Integration Designer from a command-line:

– 2000Windows From the package group installation directory, run the wid.exe command. By default, the
package group installation directory is

C:\IBM\IntegrationDesigner\v8.0

Note: Ensure that the Windows date and time are correct and match the settings of your BIOS. If
the date and time are not correctly set, IBM Integration Designer will fail to launch with the
following error message:
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Exception in org.eclipse.equinox.internal.p2.reconciler.dropins.Activator.start()
of bundle org.eclipse.equinox.p2.reconciler.dropins

– 2000Linux From the package group installation directory, run the ./wid.bin command. By default, the
package group installation directory is

/opt/IBM/IntegrationDesigner/v8.0 if you installed as an administrative user
user_home/IBM/IntegrationDesigner/v8.0 if you installed as a nonadministrative user

If you are installing IBM Integration Designer to work with the Process Center and the Process Center is
not yet installed, cancel the window that prompts for the connection. Otherwise, enter the URI of the
Process Center in the following format:
http://server_name:port number/ProcessCenter

For example:
http://myserver.toronto.com:9080/ProcessCenter

Enter your user ID and password. Click Connect.

Using the "-clean" option when starting IBM Integration Designer
The -clean option can be used on IBM Integration Designer startup and it performs several functions.

IBM Integration Designer is based on the Eclipse Platform which caches all plugin.xml files into a single
repository for quicker loading. If you used IBM Integration Designer before installing a new plug-in, you
should start IBM Integration Designer once with the -clean option.
1. From a command line, change to the package group installation directory where you installed IBM

Integration Designer.
2. Run the command to start IBM Integration Designer with the -clean option.

2000Windows wid.exe -clean

2000Linux ./wid.bin -clean

This -clean option forces IBM Integration Designer to rebuild the Eclipse repository. This applies to
anything that is installed into Eclipse by extracting it into its plugins folder. The option also
v removes and regenerates manifest files.
v removes cached binaries and regenerates them from the newly created manifest files.
v removes and regenerates JXE information.
v removes and regenerates the runtime plug-in registry.

Beyond this it is up to each plug-in that is listed in the configuration directory to handle what it does
when -clean is used.

It is a good practice to start IBM Integration Designer using the -clean option after applying any Interim
Fixes. This will ensure that the plug-in registry is regenerated to reflect any changes from the applied
fixes. This only needs to be done once after applying any Interim Fix, as running with -clean takes
considerable time in regenerating the plug-in registry.

Installing on Citrix Presentation Server
You can install and run IBM Integration Designer on a Citrix Presentation Server so that multiple users
can then connect remotely from their Citrix Presentation Server clients.

Follow these instructions to install IBM Integration Designer to run on Citrix Presentation Server.
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Note: Throughout this text, the terms “installer” and “product installer” refer to the user ID that installed
IBM Integration Designer.
1. When you install IBM Integration Designer on the server, ensure that you are logged on as a user

with administrator access.
2. After installing, ensure that the installation directory is read-only. This is the product directory, not the

shared install directory. This step will ensure that the configuration information is written in the home
directory. If this measure is not taken, all users will end up using the same location for their
configuration area, which is not supported.

Note: Ensure that client users are granted write permission to the following directory, or the
integrated test environment server status cannot be detected:install_root\runtimes\bi_version_stub\

3. When launching IBM Integration Designer from a client, the workspace is created in a directory
specified by the user.

4. In order to use the servers in the test environment, a profile is required for each nonroot user. The
product installer can grant write permission to the appropriate IBM Business Process Manager files
and directories to other nonroot users. The nonroot users can then create profiles. Alternatively, the
product installer can create a group for users who are authorized to create profiles or give individual
users the authority to create profiles. The following example task shows how to create a group that is
authorized to create profiles.

Configuring the Citrix Presentation Server
The installer can perform the following steps to create the “profilers” group and give the group
appropriate permissions to create a profile.
1. Log on to the IBM Integration Designer system as the product installer (the product installer can be a

root/Administrator or nonroot user).
2. Using operating system commands, do the following tasks:

a. Create a group named “profilers”, which will contain all users who can create profiles.
b. Create a user named user1, who can create profiles.
c. Add users product_installer and user1 to the profilers group.

3. 2000Linux Log off and log back on as the installer to pick up the new group.
4. As the product installer, use operating system tools to change directory and file permissions.

a. 2000Linux The following example assumes that the variable $WASHOME is the IBM
Business Process Manager root_installation_directoryopt/ibm/BPM/v8.5
export WASHOME=opt/ibm/BPM/v8.5
echo $WASHOME
echo "Performing chggrp/chmod per WAS directions..."
chgrp profilers $WASHOME/logs/manageprofiles
chmod g+wr $WASHOME/logs/manageprofiles
chgrp profilers $WASHOME/properties
chmod g+wr $WASHOME/properties
chgrp profilers $WASHOME/properties/fsdb
chmod g+wr $WASHOME/properties/fsdb
chgrp profilers $WASHOME/properties/profileRegistry.xml
chmod g+wr $WASHOME/properties/profileRegistry.xml
chgrp -R profilers $WASHOME/profileTemplates

b. Issue the following additional command where profile_template_name is default, dmgr,
or managed:
chmod -R g+wr $WASHOME/profileTemplates/profile_template_name/documents

The ownership of files is preserved when the files are copied to the profile directory during profile
creation. You granted write permission to the profile directory so that files copied to the profile
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directory can be modified as part of the profile creation process. Files that are already in the
profileTemplate directory structure before the start of profile creation are not modified during
profile creation.

c. 2000Linux Issue the following additional commands:
chgrp profilers $WASHOME/properties/Profiles.menu
chmod g+wr $WASHOME/properties/Profiles.menu

d. 2000Windows The following example assumes that the variable $WASHOME is the IBM Business
Process Manager root installation directory C:\IBM\ProcServer\v8.5. Follow instructions in the
Windows documentation to give the profilers group read and write permission to the following
directories and their files:
@WASHOME\logs\manageprofiles
@WASHOME\properties
@WASHOME\properties\fsdb
@WASHOME\properties\profileRegistry.xml

You might have to change the permissions on additional files if the non administrative user
encounters permission errors. For example, if the product installer authorizes a non administrative
user to delete a profile, then product installer might have to delete the following file:

e. 2000Linux

install_root/properties/profileRegistry.xml_LOCK

f. 2000Windows

install_root\properties\profileRegistry.xml_LOCK

Give write access to the nonroot user for the file to authorize the user to delete the file. If the
nonroot user still cannot delete the profile, then the product installer can delete the profile.

The installer created the profilers group and gave the group proper permissions to certain directories and
files to create profiles. These directories and files are the only ones in the installation root of IBM
Integration Designer to which a nonroot user needs to write to create profiles.

Modifying installations
The Modify Packages wizard in the IBM Installation Manager enables you to change the language and
feature selections of an installed product package.

Note: Close all programs that were installed using Installation Manager before modifying.

To modify an installed product package:
1. From the Start page of the Installation Manager, click Modify.
2. In the Modify Packages wizard, select the IBM Integration Designer product package and click Next.
3. On the Modify page, under Languages, select the languages for the package group, then click Next.

The corresponding national language translations for the user interface and documentation for the
packages will be installed. Note that your choices apply to all packages installed under this package
group.

4. On the Features page, select the package features that you want to install and clear the features that
you want to remove.
a. To learn more about a feature, click the feature and review the brief description under Details.
b. If you want to see the dependency relationships between features, select Show Dependencies.

When you click a feature, any features that depend on it and any features that are its dependents
are shown in the Dependencies window. As you select or exclude features in the packages,
Installation Manager will automatically enforce any dependencies with other features and display
updated download size and disk space requirements for the installation.
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5. When you are finished selecting features, click Next.
6. On the Summary page, review your choices before modifying the installation package, and then click

Modify.
7. Optional: When the modification process completes, click View Log File to see the complete log.

Upgrading IBM Integration Designer
You can install upgrades to IBM Integration Designer when they are available.

For upgrading from V8.5 to V8.5.0.1, see Profile upgrade instructions for IBM Business Process Manager
Version 8.5.0 Fix Pack 1 (V8.5.0.1).

Visit the IBM Support website to check for available fix packs and interim fixes.

Installing fix packs interactively
You can install fix packs for IBM Integration Designer interactively.

By default, Internet access is required unless your repository preferences points to your local update site.

Each installed package has the location embedded for its default IBM update repository. For Installation
Manager to search the IBM update repository locations for the installed packages, the preference Search
service repositories during installation and updates on the Repositories preference page must be
selected. This preference is selected by default.

During the update process the repository for the base version of the package is required. If you have
deleted the files required for rollback in Installation Manager, then Installation Manager prompts for the
original installation disk when you upgrade to a fix pack. If you installed the product from DVDs or
other media, they must be available when you use the update feature.

See the Installation Manager information center for more information.

Important: If you created profiles in an earlier version, those profiles are preserved and you do not need
to re-create them.

You cannot use this procedure to install updates on the underlying IBM DB2 Express or IBM Cognos® BI.
You must update these products following their normal update processes.

To find and install product package updates:
1. Close all programs that were installed using Installation Manager before updating.
2. Start Installation Manager. From the Start page of the Installation Manager, click Update.

2000Windows You can also click Start > Programs > IBM > package group name > Update. For
example, click Start > Programs > IBM > IBM Integration Designer > Update.

3. If IBM Installation Manager is not detected on your system or if an older version is already installed,
then you must continue with the installation of the latest release. Follow the on-screen instructions in
the wizard to complete the installation of IBM Installation Manager.

4. If you do not have Internet access, download the interim fix or fix pack locally, extract it to its own
directory, and add the new directory to Installation Manager.
a. Start Installation Manager.
b. From the Start page, click File > Preferences > Repositories.
c. From the Repositories page, click Add Repository.
d. In the Add Repository window, browse to the new directory you created for the interim fix or fix

pack files.
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e. Select the repository.config file and click Open.
f. From the Repositories page, click OK.

5. In the Update Packages wizard, select the package group containing the product package you want
to update or select the Update all check box, and then click Next. Installation Manager searches for
updates in its repositories and the predefined update sites for the software you are updating. A
progress indicator shows the search is taking place.

6. If updates for a package are found, then they are displayed in the Updates list on the Update
Packages page below their corresponding package. Only the latest recommended updates are
displayed by default. Click Show all to display all updates found for the available packages.
a. To learn more about an update, click the update and review its description under Details.
b. If additional information about the update is available, a More info link is included at the end of

the description text. Click the link to display the information in a browser. Review this
information before installing the update.

7. Select the updates that you want to install or click Select Recommended to restore the default
selections, and click Next. Updates that have a dependency relationship are automatically selected
and cleared together.

8. On the Licenses page, read the license agreements for the selected updates. On the left side of the
Licenses page, the list of licenses for the updates you selected is displayed; click each item to display
the license agreement text. If you agree to the terms of all the license agreements, click I accept the
terms of the license agreements. Then click Next.

9. On the Summary page, review your choices before installing the updates.
a. If you want to change the choices you made on previous pages, click Back, and make your

changes.
b. When you are satisfied, click Update to download and install the updates. A progress indicator

shows the percentage of the installation completed.
10. Optional: When the update process completes, a message that confirms the success of the process is

displayed near the top of the page. Click View log file to open the log file for the current session in
a new window. You must close the Installation Log window to continue.

11. Click Finish to close the wizard.
12. Close Installation Manager.
Related information:

IBM Installation Manager information center

Rolling back fix packs
Using the Roll Back Packages wizard, you can remove a fix pack and revert to a previous version.

During the rollback process, Installation Manager must access files from the earlier version of the
package. By default, these files are stored on your system when you install a package. If the files are not
available on your workstation, you must include the location of the repository from which you installed
the previous version of the product in your Installation Manager preferences (File > Preferences >
Repository). If you installed the product from DVD or other media, they must be available when you use
the rollback feature.

Use the rollback feature if you have applied an update to a product package, and decide later that you
want to remove the update and revert to the earlier version of the product. When you use the rollback
feature, the Installation Manager uninstalls the updated resources, and reinstalls the resources from the
previous version.

Note: A rollback process to a stand-alone server can disable the WebSphere test environment. You must
reset the test environment profile after you complete the rollback process. To reset a test environment
profile, see Creating or resetting default server profiles.
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See the help in the Installation Manager for more information on using the Rollback wizard.

To roll back an updated package, complete the following steps:
1. On the Start page of the Installation Manager, click Roll Back to start the Rollback wizard.
2. From the Roll Back Packages list, select the package that you want to roll back.
3. Complete the wizard according to the on-screen instructions.
Related information:

IBM Installation Manager information center

Installing fix packs silently
You can install fix packs for IBM Integration Designer using the command line.

You cannot use this procedure to install updates on the underlying IBM DB2 Express or IBM Cognos BI.
You must update these products following their normal update processes.

To update IBM Integration Designer silently, complete the following steps:
1. Read and accept the license terms before updating. Adding -acceptLicense to the command line

means that you accept all licenses.
2. Run the following command:

Important: If you are running Windows 7, Windows Vista, or Windows Server 2008, start your
command prompt by right-clicking and selecting Run as administrator.

2000Windows

extract_directory\disk1\IM_win32\tools\imcl install com.ibm.websphere.integration.developer.v80 -acceptLicense -installationDirectory location -repositories repository -sh

2000Linux

extract_directory/disk1/IM_linux/tools/imcl install com.ibm.websphere.integration.developer.v80 -acceptLicense -installationDirectory location -repositories repository -sh

where:
v location is the path to the directory where you want to update the products.
v repository is the path to the repository where you have extracted the fix pack files. For more than

one repository, separate the repository locations with commas.
v logName is the name of the log file to record messages and results.

3. If you also want to update the test environment, run the same command again with the correct
installation directory and the required product IDs:

2000Windows

extract_directory\disk1\IM_win32\tools\imcl install list_of_product_IDs -acceptLicense -testInstallationDirectory location -repositories repository -showVerboseProgress -l

2000Linux

extract_directory/disk1/IM_linux/tools/imcl install list_of_product_IDs -acceptLicense -testInstallationDirectory location -repositories repository -showVerboseProgress -l

where:
v list_of_product_IDs is a list of the IDs for the products you want to update, separated by spaces.

Table 6. Product IDs for test environment

Product Product ID

IBM BPM Advanced: Process Server com.ibm.bpm.PS.V80

IBM Business Monitor com.ibm.websphere.MON.V80
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Table 6. Product IDs for test environment (continued)

Product Product ID

WebSphere Application Server Network Deployment com.ibm.websphere.ND.v80

v location is the path to the directory where you want to update the products.
v repository is the path to the repository where you have extracted the fix pack files. For more than

one repository, separate the repository locations with commas.
v logName is the name of the log file to record messages and results.

Installation Manager updates the list of products and writes a log file to the directory that you specified.

The following example updates IBM Integration Designer on Windows.
imcl install com.ibm.websphere.integration.developer.v80 -acceptLicense -installationDirectory C:\IBM\IntegrationDesigner\v8.0 -repositories D:\temp\IID\Fixpack1 -showVerbo

Related reference:

Command-line arguments for imcl
Related information:

IBM Installation Manager information center

Uninstalling IBM Integration Designer
You can uninstall IBM Integration Designer interactively or silently.

Uninstalling IBM Integration Designer
The Uninstall option in the Installation Manager enables you to uninstall packages from a single
installation location. You can also uninstall all the installed packages from every installation location.

To uninstall the packages, you must log in to the system using the same user account that you used to
install the product packages. A package cannot be uninstalled when another package has a dependency
on it, unless the dependent package is also selected to be uninstalled.
1. Close the programs that you installed using Installation Manager.
2. Stop all running servers.

3. From the Start page of the Installation Manager, click Update. 2000Windows You can also click Start >
Programs > IBM > package group name > Uninstall. For example, click Start > Programs > IBM >
IBM Integration Designer > Uninstall.

4. On the Uninstall Packages page, select IBM Integration Designer and associated packages that you
want to uninstall.

Tip: 2000Windows If you started Installation Manager from the Start menu (Start > ... > Uninstall) in the
previous step, your IBM Integration Designer edition is pre-selected for uninstallation on the Uninstall
Packages page.
If you no longer need to use DB2® Express, or intend to reinstall IBM Integration Designer, select the
IBM DB2 Express option to uninstall DB2 Express.CAUTION:
Only select the option to uninstall DB2 Express if you are sure that no other product is using DB2
Express. Selecting this option will delete all the DB2 Express databases and database assets even if
other products, including products on a remote system, might use DB2 Express on this system.

5. On the Summary page, review the list of packages that will be uninstalled, and then click Uninstall.
After the uninstallation finishes, the Complete page opens.

6. Click Finish to exit the wizard.
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When IBM Integration Designer is uninstalled, all profiles that are augmented to IBM Integration
Designer are removed, including any WebSphere Application Server profiles that are augmented to IBM
Integration Designer.

Uninstalling silently
You can uninstall the IBM Integration Designer product package in silent installation mode. When you
uninstall in silent mode, the user interface is not available.
Related information:

IBM Installation Manager information center

Uninstalling silently using the command line
You can use the command-line mode of the Installation Manager to uninstall IBM Integration Designer.

Close all programs that you installed using the Installation Manager.

To uninstall, you must log in to the system using the same user account that you used to install.

To uninstall IBM Integration Designer using the command line, complete the following steps:
1. Open a command prompt, and change directories to the /eclipse/tools directory under Installation

Manager.

Important: If you are running Windows 7, Windows Vista, or Windows Server 2008, start your
command prompt by right-clicking and selecting Run as administrator.

2. Make the appropriate replacements and run the following command:
imcl uninstall list_of_product_IDs -installationDirectory installationDirectory -log logLocation

a. Replace list_of_product_IDs with a list of the IDs for the products you want to uninstall,
separated by spaces.

Table 7. Product IDs

Product Product ID

IBM Integration Designer com.ibm.integration.designer.v80

Installation Manager com.ibm.cic.agent

b. Replace installationDirectory with the location where you installed the product.
c. Replace logLocation with the location and file name to log the information.

3. If you also want to uninstall the test environment, make the appropriate replacements and run the
same command again:
imcl uninstall list_of_product_IDs -installationDirectory testInstallationDirectory -log logLocation

a. Replace list_of_product_IDs with a list of the IDs for the products you want to uninstall,
separated by spaces.

Important: The DB2 Express installation might be used by multiple products, including products
on a remote system. If you uninstall DB2 Express, all DB2 Express databases and database assets
are deleted.

Table 8. Product IDs for test environment

Product Product ID

IBM BPM Advanced: Process Server com.ibm.bpm.PS.V80

IBM Business Monitor com.ibm.websphere.MON.V80

WebSphere Application Server Network Deployment com.ibm.websphere.ND.v80
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Table 8. Product IDs for test environment (continued)

Product Product ID

DB2 for Linux 32-bit com.ibm.ws.DB2EXP97.linuxia32

DB2 for Linux 64-bit com.ibm.ws.DB2EXP97.linuxia64

DB2 for Windows 32-bit com.ibm.ws.DB2EXP97.winia32

DB2 for Windows 64-bit com.ibm.ws.DB2EXP97.winia64

IBM Cognos BI for Windows x86 (32-bit) com.ibm.ws.cognos.v1011.winia32

IBM Cognos BI for Windows x64 (64-bit) com.ibm.ws.cognos.v1011.winia64

b. Replace installationDirectory with the location where you installed the product.
c. Replace logLocation with the location and file name to log the information.

Installation Manager uninstalls the list of products and writes a log file to the directory that you
specified.
Related reference:

Command-line arguments for imcl

Uninstalling silently using a response file
You can create a response file and then run a command to use that response file to uninstall IBM
Integration Designer.

Close all programs that you installed using Installation Manager.

To uninstall, you must log in to the system using the same user account that you used to install.

To silently uninstall IBM Integration Designer, complete the following steps:
1. Create the response files that will uninstall the required base products and IBM Integration Designer.

Copy one of the sample response files in the following directory to create your own response file:
To uninstall both IBM Integration Designer and the test environment: dvd_root/disk1/
responsefiles/responsefile.uninstall.iid.testenv.xml

To uninstall IBM Integration Designer alone: dvd_root/disk1/responsefiles/
responsefile.uninstall.iid.xml

2. Modify the parameters as directed in the text of the response file templates to create your response
files. You can also create response files by recording your actions in Installation Manager. When you
record a response file, the selections that you make in Installation Manager are stored in an XML file.
When you run Installation Manager in silent mode, Installation Manager uses the data in the XML
response file to perform the installation.

3. Run the following command to uninstall both IBM Integration Designer and the test environment:

2000Windows

IM_location\tools\imcl.exe input extract_location\disk1\responsefiles\responsefile.uninstall.iid.testenv.xml -log silentuninstall.log

2000Linux

IM_location/tools/imcl input extract_location/disk1/responsefiles/responsefile.uninstall.iid.testenv.xml -log silentuninstall.log

Run the following command to uninstall IBM Integration Designer alone: 2000Windows

IM_location\tools\imcl.exe input extract_location\disk1\responsefiles\responsefile.uninstall.iid.xml -log silentuninstall.log

2000Linux

IM_location/tools/imcl input extract_location/disk1/responsefiles/responsefile.uninstall.iid.xml -log silentuninstall.log
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Installation Manager uninstalls IBM Integration Designer and writes a log file to the directory that you
specified.
Related information:

IBM Installation Manager information center

Troubleshooting the installation process
There are a few problems you might encounter when installing or removing IBM Integration Designer.

The table provides a list of problems, descriptions and solutions.

Table 9. Possible problems with installation.

Issue Solution

Exceptions thrown during installation of IBM Integration
Designer. The Installation Manager log files contain the
following error:

java.io.Exception: CreateProcess: "C:\...\security.update.bat" error = 5

The error indicates file-access permission problems. This
problem can be caused by anti-virus software interfering
with the installation process.

Ensure that you have sufficient permissions to install on
this system and disable anti-virus software while you
install IBM Integration Designer.

The test server does not appear in the Servers view. 1. Verify the profile was created. The default profiles
directory is one of the following directories:

2000Windows C:\IBM\IID\PS\v8.5\profiles

2000Linux /opt/ibm/IID/PS/v8.5/profiles

2. Open a command prompt and navigate to the
directory where IBM Integration Designer is installed.
Enter the following command:

2000Windows wid.exe -clean

2000Linux ./wid.bin -clean

3. If the server still does not appear, create a new server
following the instructions in Creating servers in the
test environment.

Reinstalling cannot create new profile.

If you try to reinstall to the same location, or if you try
to reinstall after a failed uninstall, the installation might
fail because a new profile cannot be created.

If databases were created for the test environment, the
databases must be dropped before you can create a new
profile.

If the databases are not automatically dropped during
uninstall, you must drop them manually.

v For the qesb profile, the default databases are
ECMNDB and QECMNDB (one or both)

v For the qbpmaps profile, the default databases are
QBPMDB, QPDWDB, and QCMNDB

v For the qmwas profile, the default databases are
MONITOR and COGNOSCS

v For the qmbpmaps profile, the default databases are
QBPMDB, QPDWDB, QCMNDB, MONITOR, and
COGNOSCS

v For the qmesb profile, the default databases are
ECMNDB, QECMNDB, MONITOR, and COGNOSCS
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